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Getting Started
Congratulations on your purchase of a ViewSonic Convertible Tablet PC 
V1250. The V1250 is a fully functional PC with built-in LAN, and Wi-FiTM 
wireless connectivity. With your V1250 you will be able to organize and access 
important business and personal information. In addition, you will be able to 
send and receive e-mail and access the Internet. This user guide will help you set 
up your V1250 and introduce you to its many features.

Important! Save the original box and all packing material for future shipping. 

Package Contents
If anything is missing in your Package Contents from the list below, or if you 
have any technical support issues, contact ViewSonic before returning the 
product. See the Customer Support table in this guide. 

Optional Accessories
The Tablet PC V1250 offers a host of optional accessories on our web site to 
improve its use including the following: 

Optional Warranties/Insurance
• 3 year Extended Warranty
• 1-3 year Accidental Damage Insurance

For more information or to purchase accessories or Optional Warranties, go to 
the web site for ViewSonic listed in the Customer Support table in this user 
guide and click on Accessories.

• Tablet PC V1250
• Stylus and tip remover with 5 

replacement stylus tips
• AC Adapter and Power Cord(s)
• Carrying Case

• Battery Pack
• Recovery CD Package
• Quick Start Guide
• User Guide on C:\V1250\UG

• Docking Station
• Portfolio Bag
• Additional SODIMM memory

• External Firewire CD or DVD/CD-
RW

• Stylus
• Additional Battery Pack
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Precautions
• For best viewing conditions view the 

screen from a distance of 15" to 18". 

• NEVER REMOVE THE REAR 
COVER. Your V1250 contains high 
voltage parts. You may suffer serious 
injury if you touch these parts. 

• Avoid exposing the screen to direct 
sunlight or another heat source. The 
screen should be facing away from 
direct sunlight to reduce glare.

• Always handle your V1250 with care; 
dropping your V1250 could void the 
warranty.

• Do not operate your V1250 outside in a 
wet, damp or extremely cold 
environment.

• Do not place heavy objects on the 
screen, video cable, or power cord.

• If smoke, abnormal noise, or strange 
odor is present, immediately switch the 
V1250 off and call your dealer or 
ViewSonic.

• Use only the AC/DC power adapter 
supplied with your V1250.
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Knowing Your V1250

V1250 Tour
This section shows the following views of visible ports and buttons:

Front View Back View

Left View Bottom View

Front View

Security Key 
(Ctrl-Alt-Del)

Journal

Sleep

Wireless 
On/Off

Rotate

Microphone

Open latch

LCD Display

Wireless ON/OFF

Charging status

Power

HD access

Auto-brightness sensor
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Back View

VGA port

DC IN

Modem

Ethernet

USB

Audio OUT

Mic IN

USB
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Left View

Power ON latch

SD  Secure Disk, or
MS  Memory Stick slot, or 
MMC  Multi Media Card

Stylus slot

PC card slot

IEEE 1394 Firewire

Download from Www.Somanuals.com. All Manuals Search And Download.



ViewSonic   Tablet PC V1250 7   

Bottom View

Battery Pack 
Compartment

Memory 
Expansion 
Slot

Hard Drive 
Expansion Slot

Docking Station 
Port Connection

Battery Pack 
Latch

Screw
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Converting to a Tablet
To convert the V1250 to a tablet, do the following.

1. Push in and slide the latch to the left while gently opening the 
display screen. Open the display to a vertical position as 
shown below.

2. Turn the display screen clockwise around in a half circle until 
you see the back of the display.
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3. Press and slide the latch to the right. 

4. Align the two white marks shown below as you close the 
display flat against the keyboard and the tablet clicks into 
place. 

5. Now you have a Tablet PC. For more information on using the 
Tablet PC, see the V1250 User Guide.
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Performance Features

High Performance Processor
The V1250 is equipped with a Mobile Intel® Pentium M Processor. 
Intel 855 GM with 400 MHz Processor Side Bus. Meets Intel 
Centrino convertible tablet platform criteria with 12.1 LCD and 
EM type digitizer.

Convert to PC
Innovative and patented convertible notebook-to-tablet PC design.

Input
Supports inking and pen input for easy note-taking, form-filling, 
and e-book application. BIOS-level signature verification (written 
password) for security.

Memory
The V1250 is equipped with a fast SO-DIMM DDR SDRAM.

Advanced Graphic Engine
The V1250 comes with an integrated Intel video processor for high 
performance graphics.

Expandability
The system offers one SO-DIMM slot for memory expansion, 
allowing users to easily increase the system’s capacity as the need 
arises.
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Bright LCD Touch-screen Display
The system is equipped with 12.1 inch TFT XVGA touch-screen 
display panel for clear text and brilliant colors. Built-in light 
sensor for auto-adjustment of LCD brightness to save battery life.

Wireless LAN, Fast Ethernet and Modem 
Connectivity
For network access capability, the V1250 provides a built-in Wi-Fi 
LAN adapter, a Fast Ethernet adapter, and a 56K modem.

Internal Antenna
The built-in wireless LAN antenna is used to transmit and receive 
data from a WiFi access point.

Additional Expansion and Connectivity
The V1250 offers a full array of I/O ports including two Universal 
Serial Bus (USB) ports, microphone and audio out jacks, external 
VGA port, Firewire port, and a multi-pin connector for the 
optional Tablet PC Docking Station. The V1250 also includes a 
Type II PC Card slot and a multi-card slot for additional 
expansion.
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Software Included
• Windows® XP Tablet PC Edition which includes:

• Microsoft® Internet Explorer
• Microsoft Outlook Express
• Microsoft Windows Media Player

• Adobe Acrobat Reader
• Microsoft eBook Reader
• Citrix® ICA® Client
• Colligo Software – Eval
• Franklin Planner – Eval
• Alias Wavefront – Eval
• Panda AntiVirus – Eval
• Power One Finance Calculator
• Zinio Reader – Eval

Indicators – LED Status Indicators
The LED Status Indicators on the top of the V1250 display the operating status 
of your V1250.

The Power Indicator LED

• Green Light - indicates that the unit is ON.
• Light Off - indicates that the unit is OFF.

The Hard Drive (HDD) Access LED

• Flashing Green - indicates that the hard drive is being accessed.

The Battery Charge Indicator LED

• Red - indicates that the V1250 is charging.
• Off - indicates that the battery is charged.

The Standby Indicator LED

• Green - indicates that the V1250 is charging.

The Wireless Indicator LED

• Green - indicates that Wireless LAN is on.
• Off - indicates that Wireless LAN is off.
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Using the Keyboard
For more information, see the Special Keys – Function Table 
below.

Function Hotkey Beep

Help Fn+F1 No

Sleep Fn+F2 Yes

Display Toggle Fn+F3 No

Display On/Off Fn+F4 No

Speaker On/Off Fn+F5 No

Num Lock Fn+F11 No

Scroll Lock Fn+F12 No

Brightness Up Fn+Right Cursor No

Brightness Down Fn+Left Cursor No

Volume Up Fn+Up Cursor No

Volume Down Fn+Down Cursor No
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Using the Touch Pad
The Touch pad shown below acts like a mouse with special control keys.

Scroll up/down, & push to Enter

Right click - context menu

Open Internet

Escape

Switch between applications
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Storage

Hard Disk Drive
Your V1250 offers a user-removable Hard Disk Drive. To replace, 
do the following:
1 Using a medium-size screwdriver, remove the screw holding the HD 

Bay cover.

2 Carefully remove the cover to expose the Hard Drive then slow pull it 
out using the plastic tab provided.

3 Remove the two screws holding the Hard Drive holder.

4 Install the Hard Drive holder to the new hard drive and replace the 
screws.

5 Replace the HD Bay cover and re-install the screw.

Optical Disk Drive
Your V1250 offers an Optical Disk Drive (Optional – see 
additional Accessories) which you can use to load and run files 
from a Compact Disc. For more functionality, you can opt for the 
DVD/CDRW Combo ODD which supports CD Burning and DVD 
media.
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Display
Your V1250 uses a high performance 12.1-inch active matrix TFT panel that 
will display millions of colors at 1024 x 768 resolution.

Caution: Do not place heavy objects on the LCD panel. Doing so may damage 
the display.

Extending the Life of the TFT Display Device
Observe the following guidelines to maximize the life of the display.

1 Set the Brightness to the lowest comfortable setting.

2 When working at your desk, connect your V1250 to an external monitor and 
disable the internal display.

3 If you are using AC power and have no external monitor attached, change to 
Suspend Mode when not in use.

Adjusting the Display Brightness
To increase the brightness, press the Function key [Fn] and the right arrow [ ]. 
To decrease brightness, press [Fn] and the left arrow key [ ]

Automatic Brightness
You can set your V1250 to have the brightness automatically adjust according to 
the illumination of the environment you are in. This is very useful when using 
the V1250 as a tablet and you have no access to the keys for Brightness 
Adjustment.

To set your V1250 to enable Automatic Brightness:

1 Click on Start->Control Panel->Display. If you do not see the Display Icon, 
click Switch to Classic View located on the top left corner of the Control 
Panel window.

2 Click on Settings then click the Advanced Tab.

3 Click on the Screen Rotation tab and select Auto Change by Light Sensor. 
See screen shot below.
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4 Click Apply or OK.

Screen Rotation
To rotate the screen from Portrait to Landscape mode or vice versa, press the 
Rotate button ( ) on the Tablet PC. See the Front View shown earlier in this 
user guide.
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XP Control Panels
Your V1250 running on XP has two ways to view the Control Panel as shown 
below: the Category View and the Classic View. 

Click here to 
switch to 
Classic View 

Click here to 
switch to 
Category View
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Audio

Adjusting the Audio
Adjust Windows® audio features by pressing [Fn] on your keyboard and the up 
key [ ] or [Fn] and the down key [ ]. Or, from the speaker symbol in the task 
bar or the control panel. For more information on keyboard shortcuts including 
Mute audio, see the Special Function Key table.

[Fn] Function key Audio up [ ] key

Audio down [ ] key

Audio mute [F5] key

Built-in Speakers
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Battery Pack

The Lithium-Ion Battery
Your V1250 uses a removable Lithium-Ion battery pack that provides power 
when you don’t have access to an AC outlet.

Handling Tips

• Do not touch the metal ends of the battery connector.
• Do not expose battery packs to temperatures below 32 degrees Fahrenheit (0 

degree Celsius) or above 140 degrees Fahrenheit (60 degrees Celsius). Doing 
so may adversely affect the battery pack.

Charging the Battery and Charging Time

With the battery pack connected to the V1250, plug the AC adapter 
into the V1250 and into an electrical outlet as shown in the Quick 
Start Guide. 
The battery continues to charge while you use the V1250 if the unit 
is plugged into an AC outlet. When the battery is fully charged, the 
battery charge indicator is off.

IMPORTANT: Be sure to reserve adequate charge time before 
traveling.

CAUTION

Before using the V1250 for the first 
time, leave the unit turned off while 
charging the battery fully for up to 
2.5 hours. Failure to fully charge 
the battery before using the V1250 
may adversely impact the battery’s 
overall life.
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Checking the Battery Level
You can check the remaining battery 
power in the Windows® battery status 
indicator located at the lower right-hand 
corner of the task tray as shown on the 
right.

The Battery Status icon only appears in the task tray while the unit 
is running on battery power but not while the unit is running off an 
external power source through the AC Adapter.
You can also access the power meter by clicking the Power 
Options icon in the Windows Control Panel.

Prolonging the Battery’s Life and Usage Cycles
There are ways to prolong the useful life of the battery.
• Store the battery pack at room temperature. Higher 

temperatures tend to deplete battery power at a faster rate.
• Make good use of the power management function. Save To 

Disk saves the most energy by storing current system contents 
in a hard disk space reserved for this function.

• Disable the parallel and serial ports if no devices are attached.
• Eject any PC Card from the card slot when not in use. Even 

when an inserted PC Card is not in operation, it still draws a 
small amount of power.
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Battery Warning
Low Battery Warning

The low battery condition occurs when the Battery Power falls to 
6%. At this point, a Warning Bubble appears from the task tray 
along with a short beep as a reminder.

Critical Battery Warning

The Critical Battery Warning occurs when the Battery Power falls 
to 3%. At this point, a Warning Bubble appears on the Task Tray 
along with a short beep. 

IMPORTANT: If the V1250 warns of its Critical Battery 
condition, save your current work immediately or plug in the 
supplied AC Adapter.

IMPORTANT: In Standby or Suspend Mode, a fully charged 
battery loses its power in roughly 72 hours. When kept in Storage 
unattached to the unit, the Battery Power will deplete in about 
30~60 days.
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Removing the Battery Pack
To remove the Battery Pack 
1 Lay the Tablet PC face down on a soft flat surface such as a 

towel on a table top. CAUTION: Do not scratch the LCD 
display screen.

2 Slide the Battery Latch to the left as shown below. Put your 
thumb in the Battery thumb hole and pull the Battery Pack out. 

Battery latch

Battery thumb 
hole
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Windows XP Power Management
In addition to the V1250’s built-in power management BIOS 
utility, Windows® XP also offers a similar power management 
feature. To access this feature, click the Windows Start button > 
Control Panel > Performance and Maintenance > Power Options. 
The Power Options Properties screen appears as shown below.

The Windows power management allows you to enter time-out 
values for the display and hard disk. You can also have your 
V1250 automatically enter a standby mode or shut itself down in 
the event of low or critical battery power. For more information on 
the power saving features, consult the Windows manual or on-line 
help.

Note: The V1250’s BIOS supports Windows APM and ACPI modes. This 
illustration shows the Windows ACPI dialogue box. Consult a Windows manual 
on how to use Windows ACPI settings or for more information on how to use 
the Windows power management functions.
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Power Saving Options
When battery power reaches critical low (3% remaining), the system enters 
either one of the two power saving modes:

• Stand By mode
• Hibernate Mode - Save To Disk

Stand By Mode
In Stand By mode, hardware devices, such as display panel and hard disk, are 
turned off to conserve energy. Click Start > select Turn Off Computer > click 
Stand By. To use the V1250 again, press the Power On button.

Save To Disk - Hibernate Mode
In this mode, all system data is saved to the hard disk before powering down. 
When in the hibernate mode, very little power is drawn from the battery. 

To enable the hibernation function, click Start > Control Panel > Performance 
and Maintenance > Power Options > Hibernate Option > OK under the Enable 
Hibernation option.

The Power On/Power Management Button
The V1250 power On/Off button serves two functions: to turn the unit on and to 
put the unit in Stand By (system power management). To turn the V1250 on, 
slide the power On button.

To put the V1250 in Stand By do one of the following: 

• Slide the power button. If the On button is not set up to Stand By, click the 
Windows Start button > Control Panel > Power Options > Advanced. Under 
the Running on batteries column, select the time you want before the unit goes 
into Stand By.

• Click Start > Turn Off > Stand By.

• Press Fn and F2 on your keyboard.

To wake up the system from Stand By, slide the Power On button. 

Bridge Battery Feature
You can change battery packs on the V1250 without shutting the unit off and 
preserving the current date. Place the system on Stand By (Start > Shut down > 
Stand By). Make sure that the Standby LED is on. You can now replace the 
battery pack without losing any data. 

IMPORTANT: You only have five (5) minutes to change the battery pack.
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Using your V1250

Initial Setup
1 Charge the battery

With the V1250 still turned off, let the battery fully charge the first 
time for up to 2.5 hours. Open the unit as shown in the one-page 
insert that came in the package.
Caution: The battery’s overall life may be impacted if the battery 
is not fully charged before using the V1250.

(1) Align the notches in the battery compartment as shown 
below.

(2) Gently press the battery down into the battery 
compartment until it clicks into place. Then slide the 
battery latch into the lock position.

Battery latch
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2 Connect the power cord

(1) With the V1250 turned off, plug AC/DC Adapter to the 
Power Port on the back of the Tablet PC.

(2) Plug in Power Cord to AC/DC Adapter. 

(3) Plug the power cord into an AC wall outlet. 

AC Adapter

DC-IN Connector The DC-in connector inserts into the power jack on the 
V1250.

LED The LED light on the top of the adapter appears green 
when the V1250 is plugged into an AC power source.

AC Adapter The adapter converts alternating current (AC) into 
direct current (DC) for the V1250.

AC Plug The AC plug plugs into an AC wall outlet.

2

1

3

DC-IN 
Connector

LED

AC Adapter

AC Power Cable

AC Plug
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3 Turn the V1250 on

Slide the Power ON button. 

Slide the power on button once to turn the unit on. If the unit is 
already on, then sliding the button powers the unit off.
When the V1250 is plugged into an AC power outlet, the 
battery charges as you use the V1250. For more information, 
see the Battery Power and Management section and Connecting 
the Battery section in the user guide.
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Booting up for the first time
To get started with your V1250, do any or all of the following:

1 To familiarize yourself with the features and parts of the 
V1250, see the V1250 Features section in this guide.

2 For more information on using the V1250, click on Start > All 
Programs > Tablet PC > Tablet PC Tutorials, or

3 Go to Microsoft Help.

4 To see the User Guide, go to your hard drive on C:\V1250\UG.

5 The first time you use the V1250, the screen guides you through 
the Microsoft Windows XP Tablet PC Edition setup
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Calibrating the touch screen
Although your touch screen is already factory-calibrated, there may be times 
when the V1250 screen will need to be recalibrated for higher accuracy.

The touch screen is a thin membrane on top of the LCD display that responds to 
mechanical pressure on the screen’s surface. The cursor on the screen is 
controlled using the stylus. If you notice the stylus tip touch-point not matching 
up with the cursor, you can recalibrate the touch screen.

1 Click the Windows Start button > Control Panel > Switch to Classic View > 
Tablet and Pen Settings. Under the Settings tab, click Calibrate and follow 
the on-screen instructions shown below.

2 Click the stylus in the middle of the crosshairs. The crosshairs move to 
another location on-screen. 

3 Click the stylus in the middle of the crosshairs again. Repeat this exercise 
several times until the screen returns to the Calibration Applet. 

4 Click OK, OK, and close the control panel. The recalibration takes place 
immediately upon exiting the application. No need to restart the V1250.
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Connectivity
For information on the ports, see the previous sections on the Back 
View and Side View.

Modem
Your V1250 comes equipped with a 56 Kbps V.90 internal fax/
modem. This enables you to access networks and to send and 
receive e-mail through a standard telephone line.

Connecting the Modem

1 Plug one end of the phone line into the modem port located on 
the back of the V1250. See the figure of the Back View in this 
user guide.

2 Plug the other end of the line into an analog phone wall outlet.

Warning: The internal modem is intended for use on an analog 
phone line, also called a POTS (Plain Old Telephone Service) line. 
This modem cannot be connected directly to a digital telephone 
line such as those commonly found in a business office. You can 
obtain an analog converter compatible with your digital phone 
line.

Ethernet

Fast Ethernet Network Adapter

The V1250 is equipped with a 10/100BASE-T Ethernet network 
adapter. This allows you to access and transmit data in a local area 
network.

Connect to the Network

1 Connect one end of the network cable into the Fast Ethernet 
Port (located on the side of the V1250) until the connector 
snaps securely into the port.
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2 Connect the other end of the cable to either an Ethernet outlet 
jack or to an RJ-45 port on a UTP concentrator or hub in the 
network.

Cabling Restrictions for Networks

The following restrictions should be observed for 100BASE-T 
networks:
• The maximum cable run length should be 100 meters (328 feet).
• For 100 Mbps operation, use Category 5 wiring and connections. 

Consult a Windows® manual for the software installation, 
configuration, and operation of the network.

Wireless LAN

Wi-Fi LAN Adapter
Your new V1250 comes with a built-in Wireless LAN adapter. This allows you 
to access and transmit data wirelessly to an access point. Consult your network 
administrator for instructions on connecting your wireless adapter to the 
network.

Your V1250 is equipped with a Built in Wireless Network adapter. Follow the 
steps below to set up your wireless connection or contact your network 
administrator for assistance.

1 Click on Start->Connect to->Wireless Network Connection

2 If this is the first time, a Window will be displayed that shows all available 
networks. Choose the network name desired and enter the network key on 
the 2 fields provided (leave blank if network is not encrypted). Click 
Connect.

3 If there is already a network configured and you want to add more, do 
Step#1 and a Wireless Connection Status will pop up.

4 Click on Properties and then click the Wireless Networks Tab.

5 If you see the network you want to add on the Available Networks window, 
click that connection and then Configure. Enter the Network Key and other 
information if necessary, and then click Okay.

6 If you do not see your network, click Add and enter the necessary 
information including the Network Name and Keys, and then click Okay.
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USB
Your V1250 offers 2 High Speed USB 2.0 ports that allows you to 
connect USB compliant devices such as Mice, Keyboards, 
Cameras, External Hard/Optical Drives, etc.

1394 Firewire
Your V1250 has a 1394 Firewire port that allows you to connect 
IEEE 1394 compliant devices like Digital Video Cameras, 
External Hard/Optical Drives, etc.

Expansion

PC Card
The V1250 offers a Type II PC card slot that supports CardBus and 
PCMCIA compliant devices.
To use the slot, press the ejector button to remove the dummy card 
first, and then insert the PC Card until it locks into place.  To 
remove the PC Card, press the ejector button and pull the card out 
slowly.

Multicard Slot
This slot supports Secure Disk (SD), Memory Stick (MS), and 
Multimedia Card (MMC) memory cards.
To use the slot, remove the dummy card first by pressing it and 
pulling it out slowly.  Then insert the SD/MS/MMC card until it 
locks into place.  To remove, press the card again to eject, and then 
pull to remove.
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Upgrading the System Memory
Many applications will run faster when the system’s memory 
capacity is increased. The V1250 provides one expansion socket 
located on the back of the system. You can increase memory by 
adding a Small Outline Dual In-line Memory Module, commonly 
known as a SODIMM. Module capacity can be 256 MB or 512 
MB.
Note: Your V1250 has been tested with a wide range of memory 
products on the market. However, not all memory modules are 
compatible. Go to www.viewsonic.com for a list of compatible 
V1250 modules.

Installing a New Memory Module
Upgrading the V1250 memory is a delicate process. Please 
observe the following instructions carefully or have a qualified 
technician install memory for you. Damages due to mishandling 
during this procedure are NOT covered by the manufacturer’s 
warranty.

Warning:

Changing memory while your computer is in suspend mode or in 
power-saving mode may cause permanent damage to the V1250. 
Make sure you turn off the power, unplug the AC cord, and remove 
the battery before proceeding with a memory upgrade.
Do not touch a memory module’s metallic contact edge to avoid 
possible damage from an electrostatic discharge.

To Install a New Module
1 Power OFF the V1250. Unplug the AC cord and all cables/devices attached 

to the system. Remove the battery pack. For more information, see the 
section Removing the Battery Pack.

2 Place your hand on a large metal object momentarily to discharge any static 
electricity.

3 Place the V1250 face-down on a soft flat surface. CAUTION: do not scratch 
the LCD display screen or the lid cover.
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4 Locate the memory expansion slot cover on the back of the Tablet PC shown 
below. Remove the screw. Lift the memory door off the system.

Attention: Notice the notch on the extracted module. The notch’s 
off-center placement allows the module to fit into the socket only 
in one orientation. The replacement module will be similarly 
notched to help you place it properly into its slot.

To install the new module, place it into the memory socket. The 
module will only fit in one orientation. Insert the module at an 
angle of approximately 30 degrees into the empty memory socket. 
Then press it firmly so that the contact edge is driven fully into the 
receiving socket.

Pivot the module until the latches on both sides of the socket snap 
into place. (You will feel it solidly click into place.)

Replace the Memory Slot Cover and the Screw. You have now 
completed the memory upgrade.
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Security
IMPORTANT!  It is highly recommended that both Numeric and 
Written passwords are set up.

Using the Security Lock
Use a standard Kensington lock.

Using Passwords

Using Passwords in Windows

You can setup Windows XP to enable the password protection 
feature:
1 Click on Start->Control Panel->User Accounts

2 Click on your User Name and then click on Create a Password.

3 Follow the directions on screen and click create password. Your Windows 
account is now password protected.

Using BIOS Level Password Security

Before you set up the BIOS level Security, it is recommended that 
the touch screen be calibrated first. To do this, follow these steps:

1 Turn the V1250 ON. When the ViewSonic Bird Logo appears on screen, tap 
the screen using the stylus.

2 On the drop down menu, select Pen Calibration and follow the oon screen 
instructions.

3 Setting up a numeric password

a. Turn the V1250 ON and then tap on the screen using the stylus when the 
ViewSonic Bird Logo comes up.

b. On the drop down menu, select Change Password.

c. Select Numeric Password.

d. Using your stylus, tap the numeric key pad on the screen to enter your 
desired Password on the NEW field.  Do the same thing on the Confirm 
Field.
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e. Click OK. Your BIOS level numeric password is now set.

4 Setting up a Signature Password

a. Turn the V1250 ON and then tap on the screen using the stylus when the 
ViewSonic Bird Logo comes up.

b. On the drop down menu, select Change Password.

c. Select Written Password.

d. Using your Stylus, enter your signature and click Learn.  Do this 5 times.

e. Your Signature Authentication is now set.
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Using Accessories
Accessories are optional and can be purchased through our website 
or an authorized retailer.

Docking Station

1 Connect the AC Power Adapter

The Docking Station allows you to run your Tablet PC from a 
standard AC power outlet. Connect the AC adapter and power 
cord as shown below.

Tablet PC Docking Station AC Power Adapter with power cord(s) 
(depends on region where purchased)

Docking Station - Back View
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2 Connect peripheral devices

The Tablet PC Dock adds one-touch access to common 
computer peripherals, network connectivity, integrated CD-
ROM and AC adapter. For more information see the User 
Guide that came with your Tablet PC. 

AC Power DC-IN

VGA 15-pin
USB

Ethernet USB

USB

Kensington 
Slot

IEEE1394

Audio OUT (green)
Mic IN (blue)
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4 Dock the Tablet PC

Set the Tablet PC down on the Docking Station aligning with 
the four guides shown below. Press the Tablet down onto the 
docking station until it clicks into place.
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5 Recharge the spare battery

Slide the battery into the Docking Station.

6 Press the release button with your thumb

To un-dock the Tablet PC from the Docking Station, press your 
thumb on the release button until the unit disengages.

Usage Charge LED 
Status

Battery 
Charged

System 
(low)

OFF System 
Battery

Ext. battery 
(low)

ON (charging)
OFF (Full)

Ext. Battery

System (low 
+ Ext. 
Battery 
(low)

OFF (charging 
system)
ON (charging 
ext. battery
OFF (both full)

System 
Battery will 
charge first to 
full then 
switch to the 
Ext. Battery

Notes: The 
System 
Battery has 
priority over 
the External 
Battery
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Troubleshooting

An Initial 
Check List

Check out 
these items 
first:

Check to see if the problem persists 
when all the external devices are 
removed.

Check to see that the green light 
indicator on the AC adapter is lit.

Check to see that the power cords 
are completely and firmly plugged to 
the wall outlet and to the V1250.

Check to see that the V1250 power 
indicator is on.

Check for any incorrect or loose 
cable connections. Make sure the 
latches on the connectors catch 
securely at their receptacles.

If an external device such as a USB 
CD-ROM drive, scanner, or printer 
does not function correctly when 
connected, there might be a problem 
with the device. Consult the device’s 
manufacturer first.

Some software issues may be 
resolved by contacting the software 
vendor directly.

Not all peripherals are plug-and-
play. You may need to restart the 
system with these devices powered 
up and connected beforehand.

Download from Www.Somanuals.com. All Manuals Search And Download.



ViewSonic   Tablet PC V1250 43   

Audio 
Problems

Speaker - no 
output

• The Audio-output may have been 
set to mute. Double-click the 
speaker icon in the task tray to see 
if the speaker has been muted.

• Most audio problems are software-
related.

Sound 
cannot be 
recorded

Check the Mute Setting - Double-
click the speaker icon on the lower 
right corner of the task tray to see if 
the microphone might have been 
muted.
1 From the Volume Control screen, 

click Options and select 
Properties.

2 Select Recording and click OK.

3 After clicking the OK button, the 
recording volume control panel 
appears. Review the settings to 
make sure that the Mute option 
has not been selected.

Hard Disk 
Problems

Spin If hard disk drive does not spin it 
may need to be serviced or 
replaced:

• Check the hard disk indicator LED 
to confirm a lack of spinning. Open 
a file. The LED lamp should light 
up momentarily as a file is 
accessed. If the file does not open 
and the light LED does not light, 
there may be a hard disk spin 
problem.

• Recall if your V1250 has been 
subjected to static electricity or 
physical shock. If so, you may have 
damaged the disk drive.
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Abnormal 
Sounds

If the hard drive is making abnormal 
whining noises:
• Archive files or programs that you 

no longer use by moving them to 
an alternate storage medium 
(floppy disk, optical recordable 
disk, tape, etc.) or uninstall 
programs that are no longer used.

• Many browsers store files on the 
hard drive as a cache to speed up 
the performance. Check the 
program’s Online Help for 
instructions on decreasing the 
cache size or on removing 
temporary Internet files.

• Empty the Recycle Bin frequently 
to maintain the availability of 
usable disk space. When you 
move files to the Recycle Bin, 
Windows® does not actually delete 
them until you act to empty the bin. 
To delete the files in the Recycle 
Bin, double-click the desktop 
Recycle Bin icon > File > Empty 
Recycle Bin.
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Drive is Full If the hard 
disk drive 
has reached 
its capacity:

• Archive files or programs that you 
no longer use by moving them to 
an alternate storage medium 
(floppy disk, optical recordable 
disk, tape, etc.) or uninstall 
programs that are no longer used.

• Many browsers store files on the 
hard drive as a cache to speed up 
the performance. Check the 
program’s Online Help for 
instructions on decreasing the 
cache size or on removing 
temporary Internet files.

• Empty the Recycle Bin frequently 
to maintain the availability of 
usable disk space. When you 
move files to the Recycle Bin, 
Windows® does not actually delete 
them until you act to empty the bin. 
To delete the files in the Recycle 
Bin, double-click the desktop 
Recycle Bin icon > File > Empty 
Recycle Bin.

Drive is Slow If the hard 
disk takes 
longer to 
read a file:

If you have been using the drive for a 
long time, the files may become 
fragmented. To correct potential file 
fragmentation, go to Start > All 
Programs > Accessories > System 
Tools > Disk Defragmenter to 
perform a disk defragmentation.
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Display 
Problems

If the display panel remains blank 
(black) when the system is turned 
on:

Make sure the V1250 is not in the 
power saving mode (Stand By). In 
these modes, the display is turned 
off to conserve energy but not the 
system. A steady green Power LED 
shows that the system is on but the 
display is in stand by.

To wake up the system, press the 
power button. For more information, 
see The Power On/Power 
Management Button section.
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Screen is 
Difficult to 
Read

The display resolution should be set 
to 800 x 600 for optimal viewing. If 
an external monitor is connected, 
you can change the resolution from 
the Category View or the Classic 
View. See the section XP Control 
Panels about both views.

From the Classic View
1 Click Start > click Control Panel > 

double-click the Display icon. 
The Display Properties screen 
appears.

2 Click the Settings tab > 
Advanced > Adapter tab > List All 
Modes. Select a resolution > click 
OK three times. Exit Control 
Panel.

From the Category View
1 Click Start > Control Panel > 

under Pick a category, click 
Appearance and Themes > 
Change the screen resolution > 
Settings tab > Advanced > 
Adapter tab > click List of Modes. 
A list of screen resolutions 
appears.

2 Select a resolution from the list > 
click OK three times. Exit 
Appearance and Themes.

The Screen 
Flickers

It is normal for the display to flicker a 
few times during powering up and 
shutting down operations.

Bios 
Problems

CMOS 
Checksum 
Failure 
Message

If a message, CMOS Checksum 
Failure, displays during the booting 
process:

• Contact ViewSonic Customer 
Support. See the Customer 
Support section in the manual.

• The life of the CMOS battery varies 
from between three to five years 
depending on usage.

Download from Www.Somanuals.com. All Manuals Search And Download.



ViewSonic   Tablet PC V1250 48   

Memory 
Problems

Increased 
Memory is 
not 
Recognized

If the boot up screen does not show 
additional memory installed:

• Certain brands of memory module 
may not be compatible with your 
system. Go to 
www.viewsonic.com for a list of 
compatible SODIMM.

• The memory module may not have 
been installed properly. Go back to 
the memory section to review the 
details of this operation.

• The memory module may be 
defective.

Insufficient 
Memory 
Error 
Message

If the OS issues an insufficient 
memory error message during 
operation:
• This is often a software or 

Windows®-related problem.
• Close any application programs 

you’re not using. This may free up 
some allocated memory.

• You may need to install an 
additional memory module. For 
instructions, go to the section on 
upgrading memory.
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Modem 
Problems

Connection 
Difficulties

• Be sure to disable Call Waiting.
• Excessive line noise might cause 

the connection to be dropped. To 
check line noise, put the regular 
phone handset on the line and 
place a phone call. If you do hear 
abnormal noise, try to make the 
modem connection with a different 
line or contact your local telephone 
company for service.

• Make sure the RJ-11 cable (the 
one that goes from the modem to 
the telephone line) is firmly 
connected to the modem's RJ-11 
jack and to the telephone line 
socket.

• Try a different phone line to see if 
the problem persists.

• Be sure the line has a dial tone.

Network 
Adapter 
Problems

Adapter 
Nonresponsi
ve

If the Ethernet Adapter does not 
seem to work:

• Make sure the physical 
connections on both ends of the 
cable are good.

• The hub or concentrator may not 
be working properly. Check to see 
if other workstations connected to 
the same hub or concentrator are 
working.
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100 Mbps 
Mode 
Nonresponsi
ve

If the Ethernet adapter does not 
appear to operate in the 100 Mbps 
transmission mode:
• Make sure the hub you are using 

supports 100 Mbps operation.
• Make sure that your RJ-45 cable 

meets the 100BASE-T 
requirements.

• Make sure the Ethernet cable is 
connected to the hub socket that 
supports 100BASE-T mode, not 
10BASE-T. The hub may have 
both 10BASE-T and 100BASE-T 
sockets.

PC Card 
Problems

PC Cards 
(SD/MS Slot) 
do not 
Function

• Make sure you have properly 
installed the driver for the card.

• Make sure the card is properly 
seated.

• Consult the card’s manual or 
contact the vendor for 
troubleshooting.

PC Card not 
Recognized

• Remove and insert the PC Card 
again.

• Make sure there is no IRQ 
(interrupt request) conflict with the 
card. See Windows® on-line help 
for solving IRQ conflicts.

• Reboot the V1250 to see if the 
problem persists.

• The card may be defective. Try the 
card on another system, if 
possible.
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PC Card 
Removal 
Locks Up 
Windows

If Windows Crashes or Freezes after 
removing the PC Card:
Make sure the PC Card is not in use 
before removing it. Click on the PC 
Card icon at the lower right corner of 
the task tray, select the card you 
wish to stop, then click OK. In a few 
seconds, Windows will prompt you to 
remove the card.

Performance 
Problems

Overheating If the V1250 becomes hot:

• In a high temperature operating 
environment, 95 degrees 
Fahrenheit (35 degrees Celsius) or 
more, the V1250’s case bottom 
can reach 120 degrees Fahrenheit 
(49 degrees Celsius).

• Make sure the air vents are not 
blocked.

• Certain programs that are 
processor-intensive may increase 
the V1250’s temperature to the 
point that the V1250 automatically 
slows down its CPU clock to 
protect itself from thermal damage.
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Program 
Slowing

If the 
program 
appears 
stopped or 
runs very 
slowly:

• Press the Security Key button 
(CTRL+ALT+DEL) then click on 
the Task Manager to see if the 
application is still responding.

• Restart the V1250.
• This may be normal for Windows 

when it is processing other CPU-
intensive programs in the 
background.

• You may be running too many 
applications. Try to close some 
applications or increase available 
system memory for higher 
performance.

• The processor may have 
overheated due to the system’s 
inability to regulate its internal heat. 
Make sure the V1250’s ventilation 
grills are not blocked.

Power, Start, 
and Battery 
Problems

Power Down 
on Startup

The V1250 powers down as soon as 
it is powered on:
Battery power may be extremely low. 
The circuitry prevents a complete 
power drain, which is not intended 
for Lithium Ion batteries. Use the 
power adapter to charge it for 
several hours before trying again.

Diminishing 
Battery Life

The battery life gets shorter and 
shorter:
• The battery has a finite life of about 

500 charge cycles. If your battery is 
over one or two years old, it may 
be time to have it replaced.

• Try a higher power saving setting 
in the BIOS or in Windows® Power 
Management.
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Recharge 
Failure

The battery does not charge:
• Make sure the AC adapter is 

plugged into a working power 
source.

• The battery charge indicator LED 
on the V1250 should be lit when 
you plug in the AC adapter.

• Make sure the battery module is 
fully inserted in its bay and that the 
battery latch is in its locked 
position.

• If the battery is operating at a very 
high temperature, it may not accept 
a charge.

Sleep Mode The screen does not come out of 
sleep mode.
• Tap the mouse pad with the stylus.
• Slide the power on switch once. 

Twice will turn the unit on again.

Printing 
Problems

Screen Print 
Failure

The printer does not print what is on 
the screen:
• If the printer prints strange 

symbols, this can be the result of 
garbage in the printer memory 
buffer cache. Call off all the printer 
tasks then toggle off the printer 
power switch to clear up the 
memory buffer. Turn the printer 
back online and attempt to print 
again.

• Make sure you have installed the 
correct printer driver.
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Appendix

Specifications
Processor Processor Mobile Intel® Pentium M Processor 1GHz ULV or 

higher: 1MB Level 2 Cache on die

Core Logic Chipset Intel 855GM with 400 MHz Processor Side Bus and 
ICH4 Southbridge
Meets Intel Centrino Platform criteria

Storage Capacity Hard Disk Drive 30GB or higher Enhance-IDE Hard Disk drive 
Patented HDD Shock Protection Design
Optional External Combo Optical Drive
IEEE1394 Compliant

System Memory Memory Type SDRAM PC2100/PC2700 2.5V (installed)
2 DDR Sockets (1 available)
Expandable up to 1024MB

Operating System Microsoft Windows® XP Tablet PC Edition

LCD Display Panel 12.1” TFT color LCD
1024xz 768 @ 16 Millions of colors
LCD-rotate feature converting Notebook to Tablet

Graphics Multimonitor
Display

Embedded in Intel 855 GM chipset
Enhanced 3D/2D Graphics Core
Simultaneous LCD & CRT Display with Dual View 
Support

Wireless LAN Wireless 
Connectivity

• Intel 2100 802.11b Wireless LAN
• 2.4 high sensitivity antenna

Modem Wired Connectivity • Built-in V92 56 Kbps modem with International PTT 
certification

• Built-in 10/100 BASE-T LAN

Audio • SB-Pro and MS-Sound System compatible
• Built-in microphone

I/O Ports • One RJ-11 jack for Data/Fax Modem
• One RJ-45 jack for 10/100 BASE-T LAN
• One DC-in jack for AC adapter
• One VGA port for External Display
• One Line/Mic Input jack
• One Line-out/Headphone jack
• Two USB 2.0 Ports
• One IEEE 1394 port (Firewire)
• Docking Connector

Expansion slots • One CardBus Type II Slot
• One Expansion multi-card Slot

Power • 28W-Hr Standard Li-Lon Battery Pack
• 1.5 hour Rapid Charge (unit off); 2.5 hour charge in-

use 
• 50W Slim AC Adapter

Physical 
Specifications

Dimensions

Weight

278mm x 229mm x 25.7 /29.7mm 
(10.9” x 9.3” x 1” ~ 1.17”)

4.0 lbs with Standard Battery Pack installed
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Note: Product Specifications are subject to change without notice.

Customer Support
For technical support or product service, see the table below or contact your 
reseller.

NOTE: You will need the product serial number.

Country/
Region

Web site T = Telephone
F = FAX

Email

United States

Canada

viewsonic.com

viewsonic.com/
support

T: (800) 688-6688
F: (909) 468-1202

T: (800) 688-6688
F: (909) 468-1202

vstech@
viewsonic.com

service.ca@
viewsonic.com

United Kingdom viewsoniceurope.com T: 0800 833 648
F: 01794 500801

service.eu@
viewsoniceurope.com

Europe, Middle 
East, Baltic 
countries, and 
North Africa

viewsoniceurope.com Contact your 
reseller

service.eu@
viewsoniceurope.com

Australia and New 
Zealand

viewsonic.com.au T: +61 2 9929 3955
F: +61 2 9929 8393

service.au@
viewsonic.com

Singapore/India 
and Southeast 
Asia

viewsonic.com.sg T: 65 273 4018
F: 65 273 1566

service.sg@
viewsonic.com

Other Asia/Pacific 
countries 

viewsonic.com.tw T: 886 2 2246 3456
F: 886 2 8242 3668

service.ap@
viewsonic.com.tw

South Africa viewsonic.com/asia T: 886 2 2246 3456
F: 886 2 8242 3668

service.ap@
viewsonic.com

Environmental Temperature

Humidity

Altitude

Operating: 5° ~ 35°C (41°~ 95°F) 
Non-operating: -10° ~ 60°C (-4° ~140°F)

Operating: 10% ~ 90%
Non-operating: 10% ~ 90%

Operating: 0 ~ 3000m; Non-operating: 0 ~ 12,000m 

Shock Operating: 25G/3ms; Non-operating: 180G/3ms

Vibration  Operating: 0.4G; Non-operating: 0.8G 
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Cleaning and Maintenance
• Make sure the V1250 is turned off. 
• Never spray or pour any liquid directly onto the screen or case.
• Never immerse the V1250 in any liquid.

To clean the screen

1 Wipe the screen with a clean, soft, lint-free cloth. This removes dust and 
other particles.

2 If still not clean, apply a small amount of non-ammonia, non-alcohol based 
glass cleaner onto a clean, soft, lint-free cloth, and wipe the screen. 

To clean the case

1 Use a soft, dry cloth. 

2 If still not clean, apply a small amount of a non-ammonia, non-alcohol 
based, mild non-abrasive detergent onto a clean, soft, lint-free cloth, then 
wipe the surface. 

DISCLAIMER
ViewSonic® does not recommend the use of any ammonia or alcohol-based 
cleaners on the V1250 screen or case. Some chemical cleaners have been 
reported to damage the screen and/or case of the V1250. ViewSonic will not be 
liable for damage resulting from use of any ammonia or alcohol-based cleaners. 
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Limited Warranty
Tablet PC ProductsWhat the warranty covers:

ViewSonic® warrants its Tablet PC products to be free from defects in material and workmanship during 
the warranty period. If a Tablet PC product proves to be defective in material or workmanship during the 
warranty period, ViewSonic will, at its sole option, repair or replace the product with a like product. 
Replacement product or parts may include remanufactured or refurbished parts or components. 
ViewSonic provides no warranty for the third party software included with the product. For specific 
warranty information, please see the EULAs included with the product. ViewSonic does not warrant that 
software will meet your requirements or that operation of software will be uninterrupted or error free. 
VIEWSONIC AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES AND CONDITIONS, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT.

How long the warranty is effective*:
ViewSonic Tablet PCs are warranted for one (1) year for all parts (except software) and one (1) year for 
all labor from the date of the first consumer purchase.
* For Europe: This Limited Warranty is effective in Europe for two (2) years for all parts (1 year for all 
consumable parts like batteries, and AC power adapters, etc. which should be replaced periodically) and 
two (2) years for all labor from the date of the first consumer purchase.
Who the warranty protects:
This warranty is valid only for the first consumer purchaser.

What the warranty does not cover:
1. Software
2. Any product on which the serial number has been defaced, modified or removed.
3. Damage, deterioration or malfunction resulting from:

a. Accident, misuse, neglect, fire, water, lightning, or other acts of nature, unauthorized product 
modification, or failure to follow instructions supplied with the product.

b. Repair or attempted repair by anyone not authorized by ViewSonic.
c. Damage to or loss of any programs, data or removable storage media.
d. Software or data loss occurring during repair or replacement.
e. Any damage of the product due to shipment.
f. Removal or installation of the product.
g. Causes external to the product, such as electrical power fluctuations or failure.
h. Use of supplies or parts not meeting ViewSonic's specifications.
i. Normal wear and tear.
j. Any other cause which does not relate to a product defect.

4. Removal, installation, and set-up service charges.
How to get service:
1. For information about receiving service under warranty, contact ViewSonic Customer Support. You 

will need to provide your product's serial number.
2. To obtain service under warranty, you will be required to provide (a) the original dated sales slip, 

(b) your name, (c) your address, (d) a description of the problem, and (e) the serial number of the 
product.

3. Take or ship the product freight prepaid in the original container to an authorized ViewSonic service 
center or ViewSonic.

4. For additional information or the name of the nearest ViewSonic service center, contact ViewSonic.
Limitation of implied warranties: 
THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, WHICH EXTEND BEYOND THE 
DESCRIPTION CONTAINED HEREIN INCLUDING THE IMPLIED WARRANTY OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Exclusion of damages:
VIEWSONIC'S LIABILITY IS LIMITED TO THE COST OF REPAIR OR REPLACEMENT OF THE 
PRODUCT. VIEWSONIC SHALL NOT BE LIABLE FOR:

1. DAMAGE TO OTHER PROPERTY CAUSED BY ANY DEFECTS IN THE PRODUCT, DAMAGES 
BASED UPON INCONVENIENCE, LOSS OF USE OF THE PRODUCT, LOSS OF DATA, LOSS 
OF TIME, LOSS OF PROFITS, LOSS OF BUSINESS OPPORTUNITY, LOSS OF GOODWILL, 
INTERFERENCE WITH BUSINESS RELATIONSHIPS, OR OTHER COMMERCIAL LOSS, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

2. ANY OTHER DAMAGES, WHETHER INCIDENTAL, CONSEQUENTIAL OR OTHERWISE.
3. ANY CLAIM AGAINST THE CUSTOMER BY ANY OTHER PARTY.
Effect of state law:
This warranty gives you specific legal rights, and you may also have other rights which vary from state to 
state. Some states do not allow limitations on implied warranties and/or do not allow the exclusion of 
incidental or consequential damages, so the above limitations and exclusions may not apply to you.
Sales outside the U.S.A. and Canada: 
For warranty information and service on ViewSonic products sold outside of the U.S.A. and Canada, 
contact ViewSonic or your local ViewSonic dealer.

ViewSonic Tablet PC Warranty (V2.0) Release Date: 10-15-01
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Safety Guidelines
CAUTION: The socket-outlet should be installed near the equipment and be easily accessible.
CAUTION: Use a power cable that is properly grounded. Always use the appropriate AC cord that is 
certified for the individual country. Some examples are listed below:

IMPORTANT NOTICE CONCERNING POWER CORD SELECTION
The power cord set for this unit has been enclosed and has been selected according to the country of 
destination and must be used to prevent electric shock.

For the United States and Canada
In the United States and Canada the male plug is NEMA5-15 style (shown above), UL Listed, and CSA 
Labeled. For units which are mounted on a desk or table, type SVT or SJT cord sets may be used. For 
units which sit on the floor, only SJT type cord sets may be used. The cord set must be selected according 
to the current rating for your unit. Please consult the table below for the selection criteria for power cords 
used in the United States and Canada.

For European Countries
In Europe you must use a cord set which is appropriate for the receptacles in your country. The cord set is HAR-
Certified, and a special mark that will appear on the outer sheath, or on the insulation of one of the inner conductors.

AC PLUG CORD PRECAUTIONS FOR THE UNITED KINGDOM
FOR YOUR SAFETY PLEASE READ THE FOLLOWING TEXT CAREFULLY.

IF THE FITTED MOULDED PLUG IS UNSUITABLE FOR THE SOCKET OUTLET THEN THE PLUG SHOULD BE 
CUT OFF AND DISPOSED OF SAFELY.

THERE IS A DANGER OF SEVERE ELECTRICAL SHOCK IF THE CUT OFF PLUG IS INSERTED INTO AN 
APPROPRIATE SOCKET.

If a new plug is to be fitted, please observe the wiring code as shown below.

If in any doubt, please consult a qualified electrician.

WARNING: THIS APPLIANCE MUST BE EARTHED.

IMPORTANT: The wires in this mains lead are coloured in accordance with the following code: 

Green-and-Yellow: Earth

Blue: Neutral

Brown: Live

If the coloured wires of the mains lead of this appliance do not correspond with the coloured markings identifying the 
terminals in your plug, proceed as follows:

The wire which is coloured GREEN-AND-YELLOW must be connected to the terminal in the plug which is marked by 
the letter E or by the Earth symbol or coloured GREEN or GREEN-AND-YELLOW.

The wire which is coloured BLUE must be connected to the terminal in the plug which is marked with the letter N or 
coloured BLACK. The wire which is coloured BROWN must be connected to the terminal in the plug which is marked 
with the letter L or coloured RED.

If you have any questions concerning which proper power cord to use, please consult with the dealer from whom you 
have purchased the product.

USA.................UL
Canada.............CSA
Germany..........VDE

Switzerland ..... SEV
Britain ............. BASE/BS
Japan ............... Electric Appliance Control Act

Cord Type Size of Conductors in Cord Maximum Current Rating of Unit

SJT 18 AWG
16 AWG
14 AWG

10 Amps
12 Amps
12 Amps

SVT 18 AWG
17 AWG

10 Amps
12 Amps
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Compliance and Safety Notices

Radio Frequency Interference (RFI) Compliance
United States Compliance Notice
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the Federal Communications 
Commission (FCC) Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures:

• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected.
• Consult the dealer or an experienced radio or television technician for help.

This device complies with Part 15 (B), Part 15(C) and Part 68 of the FCC Rules.

Operation is subject to the following two conditions: 1) this device may not 
cause harmful interference and 2) this device must accept any interference 
received, including interference that may cause undesired operation. 

Canadian Compliance Notice
This device complies with IC-RSS210 and IC-CS03 of the Canadian RF & 
Telecom requirements.

English - This digital apparatus does not exceed the Canada ICES-003 Class B 
limits for radio noise emissions from digital apparatus as set out in the radio 
interference regulations of the Canadian Department of Communications.

Français - Le present appareil numerique nemet pas de bruits radioelectriques 
depassant les limites applicables aux appareils numeriques de Canada ICES-003 
Class B prescrites dans le reglement sur le brouillage radioelectrique edicte par 
le Ministere des Communications du Canada.
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European Compliance Notice
Products with the CE Marking comply with both the EMC Directive (89/336/
EEC) and the Low Voltage Directive (73/23/EEC) issued by the Commission of 
the European Community.

Compliance with these directives implies conformity to the following European 
Norms:

• EN55022 (CISPR 22) Radio Frequency Interference
• EN50082 (IEC801-2, IEC801-3, IEC801-4) Electro-magnetic Immunity
• EN60950 (IEC950) Product Safety

This device complies with the requirement set out in the Council (European 
Parliament) Directive on the Approximation of the Laws of the Member States 
relating to Electromagnetic Compatibility of Radio and Telecom device (1999/
5/EC).

Japanese Compliance Notice
This is a Class B product based on the standard of the Voluntary Control 
Council for Interference from information Technology Equipment (VCCI). If 
this is used near a radio or television receiver in a domestic environment, it 
might cause radio interference. Install and use the equipment according to the 
instruction manual.

This device complies with JATE (Japan Approvals Institute for 
Telecommunications Equipment) requirement under authority of Ministry of 
Telecommunications.
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Safety Notices

Battery Safety Notice
• The battery pack is intended for use only with this device.
• Do not disassemble the pack.
• Do not dispose of the battery pack in fire or water.
• To avoid risk of fire, burns, or damage to your battery pack, do not allow a 

metal object to touch the battery contacts.
• Handle a damaged or leaking battery with extreme care. If you come in 

contact with the electrolyte, wash the exposed area with soap and water. If it 
contacts the eye, flush the eye with water for 15 minutes and seek medical 
attention.

• Do not charge the battery pack if the ambient temperature exceeds 113 
degrees Fahrenheit (45 degrees Celsius).

• To obtain a replacement battery, contact your local dealer.
• Do not expose the battery pack to high storage temperatures (above 140 

degrees Fahrenheit, 60 degrees Celsius).
• When discarding a battery pack, contact your local waste disposal provider 

regarding local restrictions on the disposal or recycling of batteries.

Lithium Battery Warning
This computer contains a lithium battery to power the clock and calendar 
circuitry. 

There is a danger of explosion if the battery is replaced incorrectly. Replace 
only with the same or equivalent type battery as recommended by the 
manufacturer. Discard used batteries according to the manufacturer’s 
instructions or local laws.

Power Supply Safety Notice
The power supply provided with this device is for use with this device only. 
Replace only with the same or equivalent type power supply as recommended 
by the manufacturer.

Download from Www.Somanuals.com. All Manuals Search And Download.



ViewSonic Corporation 

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
http://myh66.com

http://usermanuals.us
http://www.somanuals.com

http://www.4manuals.cc
http://www.manual-lib.com
http://www.404manual.com
http://www.luxmanual.com

http://aubethermostatmanual.com
Golf course search by state

http://golfingnear.com
Email search by domain

http://emailbydomain.com
Auto manuals search

http://auto.somanuals.com
TV manuals search

http://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

